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Introducción al Diseño de Sistemas Integrados	
  

q  Herramienta Xilinx EDK. 

q  Descripción hardware con EDK. 

q  Síntesis e implementación en EDK. 
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Herramienta de diseño para MicroBlaze: EDK	
  

q  ¿Qué es EDK? 

q  EDK (Embedded Development Kit) es la herramienta de diseño que Xilinx 
nos ofrece para realizar Sistemas Integrados en FPGAs, tanto para 
Procesadores Hardware (ARM, Power-PC) como para Procesadores Software 
(MicroBlaze) 

q  Permite la integración de los componentes hardware del Sistema Integrado 
y del código software para que los mismos actúen. También permite la 
Simulación, Depuración y Programación de todo el diseño. 

Herramienta Xilinx EDK 



Herramienta de diseño para MicroBlaze: EDK	
  

q  Los programas que componen la herramienta EDK son: 

q  Xilinx Platform Studio (XPS) 

q  Software Development Kit (SDK) 

q  Xilinx Microprocessor Debug (XMD) 

q  ChipScope 

q  ISE Foundation 

q  ModelSim 

Herramienta Xilinx EDK 
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q  Las fases básicas del proceso de diseño con EDK son: 

Herramienta Xilinx EDK 
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q  De forma más detallada: 

Herramienta Xilinx EDK 
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Herramienta de diseño para MicroBlaze: EDK	
  

q  Funciones del programa XPS: 

q  Gestión de proyectos 

q  Archivos Microprocessor Hardware Specification (MHS) y Microprocessor Software 
Specification (MSS) 

q  Archivo principal Xilinx Microprocessor Project (XMP) 

q  Gestión de aplicaciones software 

q  Gestión de la plataforma 

q  Ajustes del flujo de la herramienta. 

q  Opciones de la plataforma hardware. 

q  Llamada a distintas herramientas. 

q  Depuración y simulación. 

Herramienta Xilinx EDK 
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q  Funciones del programa XPS: 

Herramienta Xilinx EDK 
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q  Ventana principal de XPS: 

Herramienta Xilinx EDK 
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q  La utilidad Base System Builder (BSS) incluida en XPS nos ayudará a 
crear una plataforma hardware y unas aplicaciones software de test 
para nuestro sistema empotrado. 

Herramienta Xilinx EDK 



Herramienta de diseño para MicroBlaze: EDK	
  

q  Directorios generados por XPS: 

q  Los directorios implementation, synthesis y pcores almacenan la 
información del hardware del sistema. 

q  Los directorios TestAppMemory y TestAppPeripheral corresponden a dos 
aplicaciones software para testear el correcto funcionamiento del hardware. 

Herramienta Xilinx EDK 
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q  Archivos generados por XPS: 

Herramienta Xilinx EDK 
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Herramienta de diseño para MicroBlaze: EDK	
  

q  Ejemplo de archivo XMP (Xilinx Microprocessor Project) 

q  Descripción de las diferentes opciones del proyecto, 
tanto hardware como software. 
q  En general no debe modificarse aunque algunos 
errores de la herramienta pueden obligar a hacerlo. 

Herramienta Xilinx EDK 
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q  Ejemplo de archivo MHS (Microprocessor Hardware Specification) 

Herramienta Xilinx EDK 
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q  Ejemplo de archivo MSS (Microprocessor Software Specification) 

Herramienta Xilinx EDK 
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q  Los sistemas empotrados diseñados mediante XPS pueden integrarse 
en un sistema más complejo mediante ISE Foundation. 

Herramienta Xilinx EDK 
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q  Mediante la herramienta BSB definiremos las opciones del hardware 
(Microblaze) y añadiremos los periféricos de nuestro sistema 
empotrado. 

Descripción hardware EDK 
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q  Posteriormente podremos añadir alguno de los periféricos predefinidos 
en EDK. 

Descripción hardware EDK 
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q  También es posible definir nuevos periféricos de usuario ayudados por 
el Peripheral Wizard. 

Descripción hardware EDK 
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q  El archivo MPD (Microprocessor Peripheral Description) asigna valores a 
los diferentes parámetros de configuración del periférico y define sus 
terminales y conexiones. 

Descripción hardware EDK 
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q  Otros archivos importantes en la descripción de los periféricos son: 

q  PAO (Peripheral Analysis Order): Indica a la herramienta de síntesis el orden 
correcto para procesar las librerías y archivos HDL. 

q  BBD (Black Box Definition): Identifica los archivos que utiliza un periférico 
de usuario. Las listas de conexiones en formato .NGC se copian en el 
subdirectorio implementation del proyecto. 

Descripción hardware EDK 
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q  Mediante la opción Generate Bitstream realizamos la síntesis y la 
implementación del hardware. 

q  Al final del proceso en el subdirectorio implementation tenemos los 
archivos: 

q  system_map.mrp: Resumen de la asignación de recursos de la FPGA. 

q  system.bit: Archivo de programación de la FPGA. 

q  system.ucf: Archivo con la definición de los terminales. 

Síntesis e implementación EDK 
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q  Con ModelSim (PE o SE) podemos simular el hardware del sistema 
empotrado. Con ModelSim XE sólo podremos simular partes del mismo. 

Síntesis e implementación EDK 
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q  Mediante XPS podemos definir las opciones del software y podremos 
añadir aplicaciones software en nuestro sistema empotrado. 

Síntesis e implementación EDK 
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q  Necesitamos definir las bibliotecas y el sistema operativo para nuestra 
aplicación. 

q  Xilinx proporciona tres bibliotecas: 

q  Matemática (libm) 

q  Estándar del lenguaje C (libc) 

q  Las funciones de esta biblioteca están disponibles automáticamente. 

q  Específica de Xilinx para C (libxil) 

q  Funciones para manejo de archivos: LibXil File. 

q  Funciones para manejo de memoria: LibXil Mfs. 

q  Funciones para manejo de redes: LibXil Net. 

q  Xilinx proporciona el sistema operativo Xilinx Micro Kernel. 

Síntesis e implementación EDK 
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q  Mediante la opción Generate Libraries and BSPs de la herramienta XPS 
generamos los archivos necesarios para trabajar con las bibliotecas 
seleccionadas. 

q  Estructura de directorios creada por XPS. 

q  code: Archivos de salida del compilador. 

q  include: Archivos de cabecera (*.h) 

q  lib: Bibliotecas C estándar. 

q  libsrc: Driver software de cada periférico. 

q  El archivo xparameters.h contiene las 
direcciones base de cada periférico y sus 
identificadores. 

Síntesis e implementación EDK 
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q  El entorno EDK dispone de la herramienta SDK (Software Development 
Kit) 

Síntesis e implementación EDK 
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q  Etapas de diseño de software con SDK. 

Síntesis e implementación EDK 
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q  Podemos simular el software con la herramienta de depuración que 
incluye EDK. 

Síntesis e implementación EDK 
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q  Una vez desarrollados el hardware y el software del sistema empotrado 
debemos combinarlos para disponer de la aplicación completa y 
programar la FPGA. 

Síntesis e implementación EDK 
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q  Una vez empotrado el sistema en la FPGA podemos depurar el 
hardware y el software con GDB (GNU DeBugger). 

Síntesis e implementación EDK 
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q  Ventana de depuración del software en SDK. 

Síntesis e implementación EDK 
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q  Ventana de depuración del hardware mediante ChipScope. 

Síntesis e implementación EDK 
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q  Codepuración hardware-software mediante SDK y ChipScope. 

Síntesis e implementación EDK 
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Creación de aplicaciones software 
Una de las complejidades de empotrar MicroBlaze en una FPGA reside en conocer los periféricos que 
usamos para realizar la programación y acceso a los mismos. 

amos en éste segundo ejercicio a crear una aplicación básica que nos permita acceder a cualquier 
periférico que queramos controlar con MicroBlaze. Usaremos XPS para generar la aplicación 
software, creando el archivo de programación que verificaremos de manera hardware. Así 
mismo, usaremos un linker script simple que nos permita automatizar todo el proceso. 

El primer paso será crear un directorio, donde guardemos nuestros proyectos, con el nombre de éste 
ejercicio. Copiaremos todos los archivos del anterior ejercicio a éste directorio. Así no tendremos que 
generar de nuevo todo el hardware con el que vamos a trabajar, sólo crearemos el software. 

Una vez realizado, abriremos XPS y el proyecto copiado. Bien desde EDK o desde el Explorador de 
Windows haciendo doble clic en system.xmp 

 

 

Ejercicio 

2 

V 
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Creación aplicación software - SDK 
Lanzamos desde EDK, al igual que hicimos en el Ejercicio 1, el hardware para trabajar en SDK. Un vez en 
SDK usamos la opción File->New->Application Project y le asignaremos un nombre a nuestro proyecto 
software (Basico). 

Teniendo cuidado con tener elegido el procesador correcto (microblaze_0) y seleccionando el hardware 
generado en el ejercicio anterior con EDK (Ejercicio_1_hw_platform).  

En cuanto al soporte de la placa que estamos empleando (Board Support Package) podríamos emplear el 
generado anteriormente (Ejercicio_1_bsp_0) ya que no ha sido modificado, pero para conocer mejor la 
herramienta se va a generar uno nuevo con los archivos de soporte (Basico_bsp) de la tarjeta LX9 que se 
está empleando. 

 

 
Una vez realizados estos pasos, le damos a Next y le decimos que nos cree una Aplicación Software Vacía 
puesto que vamos a ser nosotros quienes creemos el Programa Software (Empty Application). 
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Con la opción File -> New->Source File, crearemos un archivo C  donde podremos introducir nuestro 
código, para ello, debemos indicar el nombre del proyecto en el que deseamos incluir el archivo, el nombre 
del mismo (basico.c) y el lenguaje que se va a emplear para su programación (C).  

 

El primer paso, es añadir los archivos de librerías con los cuales vamos a trabajar. Todos éstos archivos los 
encontramos en la carpeta del proyecto Board Package Support (Basico_bsp \microblaze_0\include). 

Por tanto, se pueden eliminar de la ventana de Project Explorer los proyectos que no vamos a emplear en 
este ejercicio conservando el proyecto donde vamos a realizar la programación (Basico), el de soporte de la 
tarjeta (Basico_bsp) y el hardware que generamos en el Ejercicio 1 y que vamos a emplear en este caso 
(Ejercicio_1_hw_platform). 

Pinchar sobre cada uno de ellos y con el botón derecho usar la opción Delete. Tiene que quedarnos algo 
como lo de esta imagen. 

 

Para éste ejercicio, incluiremos las librerías xparameters y xgpio. 
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El siguiente paso es conocer como se puede inicializar un periférico, si no lo hacemos, el microprocesador 
no sabrá sobre que periférico se está actuando. Si queremos usar los LEDs, podemos  navegar en la pestaña 
Project Explorer, dentro de Basico_bsp clicando sobre el archivo system.mss, en el apartado Peripheral 
Drivers seleccionar leds_4bits gpio Documentation. 

A continuación, se abrirá en el navegador una página con la descripción de la API del periférico GPIO. 

   

En ésta documentación encontramos todos los recursos para poder actuar sobre el soft IP core diseñado 
por Xilinx que nos permite acceder al periférico. 
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En la ventana que se ha abierto en el navegador seleccionamos Files. 

 

A continuación, seleccionamos el archivo xgpio.h 
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Si vamos al apartado Functions podremos ver la lista de funciones que podemos usar.  

 

Como lo primero que queremos es inicializar nuestra conexión con el periférico, debemos usar las 
funciones de XGpio_Initialize().  

 

 

 

Contiene una detallada descripción de la función XGpio_Initialize(). Hay 2 parámetros que debemos 
configurar: 

! InstancePtr: pondremos (&gp_out) que define una variable de tipo puntero que nos permite 
acceder a éste periférico. 

! DeviceId: pondremos (XPAR_LEDS_4BITS_DEVICE_ID) que es la identificación de nuestro 
dispositivo. 
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Para encontrar ésta identificación, es necesario acudir a xparameters.h. Podemos abrirla en la ruta 
Basico_bsp -> microblaze_0 -> include en la pestaña Project Explorer 

 

Por tanto, nuestro código debería tener este aspecto en este punto: 

 

 

 

Para definir todos los bits del bus de conexión con los LEDs como salidas, deberemos añadir la siguiente 
línea: 

XGpio_SetDataDirection (&gp_out, 1, 0x0) 

Buscar la documentación y entender la línea. 
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Una vez realizado lo anterior, ya podemos implementar cualquier función en C estándar. En éste caso, 
vamos a crear un simple contador que nos permita recorrer los LEDs encendiéndolos de uno en uno. 

 

 

Fijaros en la nueva función usada XGpio_DiscreteWrite(), comprender lo que hace.  

Ya estamos en disposición de compilar nuestro primer programa. Usaremos la opción Software -> Build 
All. 

 

 

Podemos observar en la ventana de la consola el tamaño que ocupa nuestro ejecutable. 
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Ahora ya tenemos lo necesario para programar la FPGA y ver como funciona nuestro código. Para ello 
debemos seleccionar el Bitstream y el BMM File generados en el hardware del Ejercicio 1 que hemos 
copiado a nuestro proyecto Ejercicio_2 y el software generado para este segundo ejercicio (Basico.elf). 

 

¿Es correcto el funcionamiento? ¿La temporización es la adecuada? Si no es así, modificar el código para 
que veamos como se recorren los LEDs. 

Crear un nuevo Proyecto en C basado en la plataforma hardware y software ya creadas para mostrar en los 
LEDs el estado de los interruptores. ¿Qué tendréis que modificar del siguiente código para que funcione? 

 



1 

Configuración periféricos GPIO 
En este cuarto diseño con MicroBlaze vamos a crear un sistema empotrado hardware configurando periféricos 
GPIO (General Purpose Input Output). 

l desarrollo de este ejercicio nos llevará a crear un diseño hardware con MicroBlaze utilizando de 
nuevo BSB pero añadiendo y configurando los periféricos GPIO. Crearemos 2 GPIO para la 
lectura de los interruptores y un pulsador externo y 1 GPIO más para la escritura en los LEDs. 

Todo ello lo mostraremos en Terminal por el Puerto Serie de la placa de desarrollo LX9. Así mismo, 
crearemos una aplicación software para gestionar estos periféricos. 

El diagrama de bloques que tendrá esta aplicación es el siguiente. 

Ejercicio 

3 
E 
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Creación sistema empotrado 
Siguiendo los pasos del Ejercicio_1, creamos un nuevo proyecto con el nombre Ejercicio_4. Definiendo 
Microblaze como nuestro microprocesador empotrado, la misma placa de desarrollo usada anteriormente, 
la misma frecuencia y el mismo tamaño de memoria BRAM. 

En este caso también usaremos el puerto USB_UART, mientras que desactivaremos la selección de los 
periféricos (LEDs y Switches). Igualmente, desactivaremos el uso de la SPI Flash, de la DDR SDRAM y de 
Ethernet. 

Debemos obtener lo siguiente y finalizamos la generación de nuestro sistema empotrado.   

 
 

Una vez abierto el entorno XPS con el nuevo proyecto creado, implementar el hardware con la opción 
Hardware -> Generate Bitstream para comprobar que no tenemos ningún error. 
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Ahora es el momento de añadir un nuevo periférico a nuestro sistema empotrado. Vamos a conectar los 
interruptores de 4 bits de la placa LX9. Se tratan como GPIO (XPS General Purpose IO). 

Para ello, hacemos doble click sobre su nombre en la pestaña IP Catalog y lo añadimos a nuestro sistema 
empotrado. Le llamaremos interruptores_4_bits. 
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Ahora vamos a configurar los parámetros del periférico creado. Para ello, pinchamos dos veces sobre su 
nombre y abrimos el cuadro de diálogo correspondiente. 

En la pestaña USER desplegamos las opciones del Channel 1 y seleccionamos un tamaño de bus de 4 bits y 
lo configuramos como solo entrada. 

 

 

De la pestaña Channel 2 podemos dejar los valores por defecto puesto que dicho canal no se utiliza. 
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Ahora conectamos el periférico creado al bus PLB. 

 

Conectamos las entradas del periférico a las señales interruptores_4_bits_GPIO_IO_pin y las definimos 
como externas en GPIO_IO. 
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El siguiente periférico a añadir y controlar, siguiendo los mismos pasos indicados anteriormente, serán los 
cuatro LEDs de la placa LX9. Le llamaremos leds_4_bits. 

En este caso el tamaño del bus también será de 4 bits. Así mismo, definiremos el Channel 1 como FALSE 
al ser un periférico de salida. 

Por último, conectamos las salidas del periférico (GPIO_IO_O) a las señales 
leds_4_bits_GPIO_IO_O_pin y las definimos como externas. 

 

 

Hacemos los mismos pasos para agregar el pulsador de la tarjeta, en este caso vamos a usar uno de los 
PMODs externos de la placa. Colocaremos un cable en dicho pin y dándole alimentación o llevándolo a 
masa lo usaremos de pulsador. Le llamaremos pulsador_1_bit. 

Estos nuevos periféricos no tienen asignada una dirección de memoria. Por tanto, debemos ir a la pestaña 
Addresses y bloquear las direcciones asignadas a los periféricos iniciales de nuestro sistema empotrado. 

Pinchamos en Generate Addresses (icono que se encuentra en la pestaña Adresses en la parte superior 
derecha) y aparecerán las direcciones de nuestros nuevos periféricos. 
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Ahora debemos añadir los periféricos a nuestro archivo de restricciones para definir la asignación de los 
terminales externos. Abrimos el archivo system.ucf que se encuentra en la pestaña Project -> Project Files. 

 

 

Para ello, debemos asignar los terminales de los periféricos. Podéis verlos en el datasheet de la PCB 
(xlx_s9_lx9_fpga_microboard-ug072711.pdf) y su definición (Avt_S6LX9_MicroBoard_UCF_110804.ucf ) 
en el archivo anterior que tenéis colgado en el Aula Virtual. 
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Observar bien la figura siguiente para saber como hacer un ‘0’ y un ‘1’ con el PMOD usando sus pines de 
3V3 y GND. 

El nombre que debemos poner a los terminales debe coincidir con el que aparece en la sección Ports del 
archivo system.mhs. Mirar como se definen los pines para saber cual es el primero, el segundo… 

 

Ahora debemos implementar de nuevo el hardware para añadir a nuestro sistema empotrado los nuevos 
periféricos y comprobar que no hay errores (Hardware -> Generate Bitstream) 

Para poder usar estos periféricos y comprobar que nuestra aplicación funciona correctamente, es necesario 
crear una nueva aplicación software. Las opciones referidas al desarrollo del software para el sistema 
empotrado son accesibles a través de la opción Project -> Export Hardware Design to SDK… 

En SDK seguimos los pasos de los anteriores Ejercicios para crear una Board Support Package referida al 
nuevo hardware creado y un archivo de Proyecto en C donde escribir nuestro código. 

Añadimos el fichero fuente pulsando el botón derecho sobre el nombre de nuestro proyecto y 
seleccionamos New->Source File, se indica el nombre del proyecto (uso_perifericos), el nombre del archivo 
(control_perifericos.c) y el lenguaje que se va a emplear para su programación (C). 

Debemos realizar un programa que lea el estado de los interruptores cuando “apretemos” el pulsador y 
muestre dicho valor en los LEDs y en Terminal. El valor debe permanecer fijo hasta que modifiquemos el 
mismo en los interruptores y volvamos a “apretar” el pulsador. 

 

 

 

 




